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This BrightRED Study Guide is just what you need to support your National 4 Administration 
and IT studies! Written by our trusted author and experienced Administration and IT teacher, 
Jane Sturrock, this book contains all the key course information and offers many practical 
activities, examples and tasks to let you focus on exactly what you need to get the most out 
of your course. Inside, you will find: 

 All the essential course content arranged in easily digestible topics.

 Full colour, highly illustrated, accessible and engaging spreads to make sure all  
that study sticks!

 Don’t forget pointers offering advice on the key facts and on how to avoid  
common mistakes.

 Tasks allowing you to build your Administration and IT skills on your  
own or in class.

 Things to do and think about sections at the end of each 
topic allow you to put your skills to the test.

Thinking of National 5? Check out the  
BrightREd digital Zone –  

for a world of tests, activities, 
 links and more at  

www.brightredbooks.net!

Bright Red Publishing’s easy to use, 
high-quality educational resources are 
trusted by teachers and custom designed 
to improve students’ study experience to 
help them to achieve their potential.

To see more of what we do and stay up 
to date with all things Bright Red:

 follow us on Twitter @_BrightRed 

 like us on facebook at  
www.facebook.com/brightredbooks 

 visit us at  
www.brightredpublishing.co.uk

 or call us on 0131 220 5804 –  
we’d be delighted to hear from you!

www.brightredpublishing.co.uk

Stationers’ Company Innovation Excellence Award 2014
Highly Commended Bookseller Industry Awards 2014
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Introduction to National 4 Administration

Introduction

Introducing National 4 
Administration

The aim of this book is to provide practical help and tips for students and teachers 
alike with regards to the knowledge and understanding and ICT skills required for 
the SQA National 4 Administration and IT course as outlined below in the course 
specification. However, many of the IT skills covered in this book would be relevant to 
anyone wishing to improve their competency in this area.

THE National 4 course
The N4 Administration and IT Course comprises three mandatory Units and an Added Value 
Unit. While this book has been broadly divided into the three mandatory units, it must be 
remembered that many of the skills and the knowledge and understanding permeate all the 
units and they cannot be completed in isolation. The practice assignments at the end of each 
unit reflect this and all tasks have relevance to the Added Value Unit.

National 4 Administration and IT Course Specification (C701 74)

Mandatory skills, knowledge and understanding
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Skills, qualities and attributes required of administrators ✔

Basic skills in using the following IT applications: word processing, spreadsheets, 
databases, presentations and desktop publishing, in familiar administrative contexts

✔ ✔

Skills in organising and supporting small-scale events ✔ ✔ ✔

Basic skills in using technology, including the internet, for electronic 
communication and investigation in familiar administrative contexts

✔

Basic skills in organising, processing and communicating simple information in 
familiar administrative contexts

✔ ✔

Knowledge and understanding of key legislation affecting employees in the 
workplace

✔

Knowledge and understanding of the key features of good customer care ✔

Further mandatory information with regards to the Course Specification, Unit Specifications 
and the Added Value Unit Specification can be found on the SQA website:  
http://www.sqa.org.uk/sqa/47431.html

Each of the mandatory units has a number of outcomes. To gain a pass at National 4 level, 
you must pass all outcomes within each of the three mandatory units as well as the Added 
Value Unit. All of these are marked by your classroom teacher. 

The specific outcomes and standards that you must achieve for each unit are as follows:

How to use this book
Instructions and information, including screen dumps where relevant, have been provided in 
a logical and progressive way in order to help you to develop and build upon your skills as 
you work through the exercises and when direct support from your teacher is not available.

Every attempt has been made to ensure all the skills and knowledge and understanding 
elements specified in each of the Unit Specifications have been included either within this 
book or included in the exercises available on the digital zone (www.brightredbooks.net). In 
some instances, extension tasks have also been included for those students progressing to 
National 5 Administration and IT or entering further study, employment or training.

Your feedback on this book would be most welcome!

Administrative practices

Outcome 1

Provide an overview of administration in the 
workplace by:

1	 Naming the main tasks, skills and qualities of an 
administrative assistant

2	 Outlining the key features of good customer care

3	 Outlining the key employee responsibilities in terms 
of health and safety

4	 Outlining the key employee responsibilities in terms 
of the security of people, property and information

Outcome 2 

Carry out administrative tasks in the context of 
organising and supporting small-scale events, 
according to a simple brief, by:

1	 Carrying out straightforward planning tasks for the 
event

2	 Editing documents to support the event

3	 Carrying out follow-up activities

IT solutions for administrators

Outcome 1

Use functions of a spreadsheet in 
line with a given task by:

1	 Editing a spreadsheet, applying 
simple formulae

2	 Sorting data within the worksheet

3	 Creating a simple chart from a 
specified range

Outcome 2

Use functions of a flat database 
in line with a given task by:

1	 Populating a database, 
using forms

2	 Editing a database

3	 Manipulating information by 
searching and sorting

4	 Creating a simple report

Outcome 3

Use functions of word processing 
in line with a given task by:

1	 Creating and editing simple 
business documents, complying 
with the prescribed house style

2	 Creating a simple table and 
sorting the data

3	 Importing data into a simple 
business document

Communication in administration

Outcome 1

Use technology to gather information in line with a 
simple brief by:

1	 Searching for and extracting simple information 
from the internet

2	 Searching for and extracting simple information 
using an internal network (intranet)

Outcome 2

Use functions of technology to prepare and 
communicate simple information in line with a 
simple brief:

1	 Using multimedia to create a simple presentation

2	 Using desktop publishing to produce a simple 
document

3	 Using an electronic method to communicate 
information



Organising and supporting small-scale events – Events organising 2 U1

OOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOO

Events organising 2

On the day of the event
Setting up the venue

•	 Set up the room in the layout required and check that any equipment is working 
and catering and refreshments are in place.

•	 Put up signs, for example, to direct those attending to the relevant room, or put 
up ‘do not disturb’ signs for any meetings. 

•	 Make sure all helpers know the location of toilets, timings of breaks and lunch and 
have an emergency contact number that can be used to contact the 
event coordinator at any time.

Organising attendees and speakers

•	 If it is a conference or training session, register 
delegates as they arrive and have them sign an 
attendance sheet, give out name badges and issue 
any materials needed. 

•	 Welcome and look after speakers or whoever is 
providing the entertainment.

•	 Have a final rehearsal if possible and check 
time schedules.

•	 As the event draws to a close, thank everyone 
for coming, including speakers and the audience, 
and make sure people know where they are going 
next, for example, if there is further catering or any 
transport arrangements.

Ask for feedback

•	 At the end of the event, issue feedback forms to those who have 
attended. Ask them to make comments about the event, how it was 
organised, the catering, accommodation and so on and to give any suggestions 
that might improve similar events in the future. You can use these feedback forms 
to eliminate any areas of weakness.

After the event 
•	 Immediately after the event tidy up the room, dispose of rubbish and ensure leftover 

food and drink is disposed of.
•	 Write to thank all speakers/entertainers for their contribution and keep them informed 

about expense payments.
•	 Ensure all outstanding invoices and bills are paid, for example, caterers and room hire.
•	 If the purpose of the event has been to raise money, tally up the amount achieved 

and publicise to those who have made a contribution. If the event was a meeting, 
prepare the Minutes of Meeting ready for the Chairperson’s signature.

•	 Meet with all those involved in the organisation of the event to discuss how it went, 
what has been learned and what would be done differently next time. Remember to 
take into account any feedback received from those attending the event. An example 
of a feedback form is shown opposite.

2120 21

Course Evaluation Form
We would like to obtain your input about this and future courses. Please help us 
by completing the following information.

1.	 Speaker’s Presentation� ■ Excellent  ■ Good  ■ Fair  ■ Poor
Comments:   

2.	 Presentation Content:� ■ Excellent  ■ Good  ■ Fair  ■ Poor
Comments:   

3.	 Was the presentation beneficial to you?� ■ Yes  ■ No
Comments:   

4.	 Did you receive the information you expected?� ■ Yes  ■ No
Comments:   

5.	 Was sufficient time provided for the presentation? � ■ Yes  ■ No
Comments:   

6.	 Accommodation:� ■ Excellent  ■ Good  ■ Fair  ■ Poor
Comments:   

7.	 Catering/Refreshments:� ■ Excellent  ■ Good  ■ Fair  ■ Poor
Comments:   

8.	 Please give any other comments you feel relevant:

 
 

Example

THINGS TO DO AND THINK ABOUT
1.	 Have a look at the layouts given and decide  

which layouts might suit:
(a)	A retirement party
(b)	A lecture about health and safety in the office
(c)	Monthly sales planning meeting 

 
 
 
 

2.	 Now that you know what is involved in organising and supporting an 
event, are there any events coming up in your school that you could 
help to run? For example, a fundraising non-uniform day – write 
down what you would do before the event, on the day of the event 
and after the event. 

Theatre U-shape Classroom

Boardroom Banquet Cabaret



Unit 2: IT solutions for administrators

Spreadsheets
An overview

Using spreadsheets
A spreadsheet allows calculations to be performed and graphs and charts to be 
created. Spreadsheets are made up of rows and columns forming a grid of cells. 
Each row has a number and each column has a letter and this means that each cell 
has its own individual address.

Spreadsheets – An overview U2

Spreadsheet tabs
The tabs, menus and commands you are most likely to use are:

Home tab

This allows you to select font and font size and styles and format your spreadsheet 
including text alignment, borders and shading, text wrapping and merging cells. 
You can also insert and delete rows and columns and use AutoSum to add up a 
column of figures and to find minimum, maximum, count numbers and average.

Page Layout tab

This allows you to select various print options including orientation, print area, 
gridlines and row and column headings and fit to one page (see later)

Formulas tab

Here you can show formulas used in your calculations

Data tab

This allows you to sort the information contained in your worksheet

Review tab

Here you can deal with comments included in the spreadsheet

2726

U2

You must ALWAYS start your 
formula with the = sign

Don’t Forget 

THINGS TO DO AND THINK ABOUT
Try making up a spreadsheet to work out your own financial situation for the next month. 
Add in all the money you expect to receive, for example, pocket money, wages from paper 
rounds, etc., then take away all the money you expect to spend and see how much you have 
left. Update your spreadsheet as the month goes on and where any of the amounts change!

For example, the address of this cell is B2.

This address is also shown in the Name box at the 
top of the worksheet.

Cells can contain text, numbers or formulae to 
carry out a calculation.

Spreadsheets use symbols within formulae similar 
to those you would use in maths:

Calculation Symbol

Addition +

Subtraction -

Multiplication *

Division /

Example

You want to find the value of sales for three items 
as well as the total sales of all items.

The calculation to find the total sales value of 
biscuits is 6 × £0.50 which will go in D4.

Using the cell addresses of these two numbers, 
the calculation used in the spreadsheet would be 
=B4*C4

You now want to do a similar calculation for crisps 
and then lemonade so copy the formula down the 
column – the computer will automatically change 
the row number as the formula is copied down.

In cell D7, you want to find the overall TOTAL 
value so the formula should be =D4+D5+D6. 
However, when adding a column or row of figures 
it is much more efficient to use the AutoSum 
button (Σ), which is found in the Home tab. The 
steps are: click in cell D7, click Σ and the computer 
will include all the required cells within the 
range so just press the return key or enter key. 
The formula now reads =SUM(D4:D6).

Example

VALUE VIEW

A B C D

1 SALES

2

3 ITEM QUANTITY PRICE TOTAL

4 Biscuits 6 £0.50 £3.00

5 Crisps 8 £0.35 £2.80

6 Lemonade 14 £0.60 £8.40

7 TOTAL £14.20

FORMULAE VIEW

A B C D

1 SALES

2

3 ITEM QUANTITY PRICE TOTAL

4 Biscuits 6 £0.50 =B4*C4

5 Crisps 8 £0.35 =B5*C5

6 Lemonade 14 £0.60 =B6*C6

7 TOTAL =SUM(D4:D6)



Communications software – Using Outlook U3

Mail
Electronic mail, or e-mail, is like 
sending a letter only the letter is 
sent over the intranet or internet 
and the recipient receives the 
message within seconds rather 
than days. E-mails can be received 
on smartphones and laptops as 
well as desktops. In order to save 
time, e-mail addresses can be saved 
in Contacts and Contact Groups 
(otherwise known as distribution 
lists) which can be set up to include 
groups of people that you might 
e-mail on a regular basis. For 
example, Mr Jones, a teacher, might 
set up a contact group consisting of 
the e-mail addresses of all pupils in 
his Admin class.

Sending a message

 Clicking on New E-mail will open a window which will allow you to 
compose a new message. You can either key in the e-mail address of the 
recipient or if you click on  this will take you into your list of contacts 
and allow you to select the appropriate address. A number of e-mail 
addresses can be put in the address box. Entering an e-mail address in 
the  box will mean that the recipient will also receive a copy of the 
message – this is normally just to keep them informed of what is happening; 
they do not need to take any action.

To send a document or file with your message use Attach File and if the 
e-mail is urgent mark it with High Importance. 

Communications software, such as Outlook, lets you send, receive and manage 
e-mails and also manage your calendar and contacts, such as friends and business 
associates. In addition, Outlook offers a task management facility as well as electronic 
“sticky notes”. 

Opening Outlook
When Outlook opens you will get a window similar to that shown below. Under the Home tab 
you can either click on New E-mail to compose a new message or on New Items where, as 
well as being able to select E-mail Message, you will also be able to set up a new Appointment, 
Contact or Task. Going further down the menu to More Items, you will also be able to access 
Note – these are like sticky notes where you can add brief messages to yourself. 

You can also access these functions by clicking on the icons in the navigation pane. 
We will now look at each of these individually.

E-mail guidelines
The following guidelines suggest how an e-mail should be composed:

•	 Include a Subject – what the e-mail is about. 
•	 Start the e‑mail with the person’s name,  ‘Good Morning/Afternoon’ or, when 

sending to a group, you could use something along the lines of ‘Colleagues’.
•	 Keep the message brief and to the point. Do not use ALL CAPS – this means that 

you are shouting! Check all spelling and grammar carefully. Does the message 
make sense?

•	 Make it clear in the message if there is an attachment.
•	 Let the reader know that you have finished your message by including a closing 

line of text or ‘Regards’ or ‘Best wishes’ or something similar.
•	  Use attachments to send files, pictures or large documents. However, be 

careful with attachments you receive as this is one of the most common ways for 
computer viruses to spread. As a rule, you should never open an attachment from 
someone you don’t know or trust. Even if you know the sender, don’t open an 
attachment you are not expecting or an attachment that looks suspicious. Some 
viruses can destroy all the data on your computer, so it’s best to play it safe!

•	 If a message is very important it can be marked with a symbol which indicates that 
it should be read as a priority. Click on .

Replying to a message

To reply to a message that has been received, click on Reply. A window will open 
showing the original message as well as providing space for your reply.

Printing e-mails
Any e-mail that has been sent or received can be printed. Simply select the e-mail, go 
to the File tab then Print in Memo Style. Printing an e‑mail will show details of date 
and time that the e-mail was actually sent as well as the message.

86 87

For some great practical tasks on 
communications software, head 
to www.brightredbooks.net/
N5AdminIT

Online

Using Outlook

Communications software

THINGS TO DO AND THINK ABOUT
Once you are happy with the information about communications software in this 
section, try out the practical exercises on pages 89 and 91.

Take time to clean out your 
inbox on a regular basis – any 
e‑mails you want to keep can 
be organised into folders.

Don’t Forget 
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